Empower Support — Shula Levin, Medtechnica

System Configuration

Login and go to Configure System

EEmpower Pro |

=10l ]

u 2 8| 2|

HELF

User: shula/Power_user
DB:  Local

Run Samples

Browse Project

Process Data Review Data

Configure System

Print Data

The Configure System window:

1. List of Projects:

To adjust Project's settings:

F-"shula,.-"Puwer_user - Configuration Manager

File Edit Wew Records Help

_lolxI
D[ o | x| 5 [F ]| rerey [EEETMM | EcVes | U |
!
- o
-2 Empower Configuration ks Name Owrer Create Date Full Auit Trail | Locked Comments
1 | Defauts System |12/25/2006 6:15:15 PM Asiaflerusalem o Mo Lock Defaul project
- B} Empower Nodes
Gystems 2 | Startup_Project06 | System (12/25/2006 6:20:43 Pht Asiatlerusalem |_ Mo Lock blank
g Libraries 3 | walid_OQApex System [1/25/2007 6:36:57 PM Asialletusalem 7l Mo Lock 00 Project with Apex Track Integration f
- €% Users
€5 User Groups

-43% User Types
= @ Plate Types

= :g System Audit Trail

o5 Offline System Audit Trail

For Help, press F1

File Edit

Wieww Records Help

ﬁ'l%l%}l ﬂ ﬁ ﬂ & ||E|I| Filter Biy: IDefauIl

=

E dit iew Update
ol -]
=-dgh Empower Configuration & Create Date Full Sudit Trail
s 1 1
- =), Empower Nodes . Open .
Systems 2 | Startup_Project06 Lpdate Statistics b Aziaflerusalem | |
-7 Libraries 3 [Valid_0QApex Backup Project Asiatlerusalem v
- €3 Users Restare Projects)
@ User Groups Delete
€27 User Types New
&2 Plate Types Clone
:g Sys_tem Audit Trail ] ] Mave Project Data
-2, OFfline System Audit Trail Lack Project "
[l

For Help, press F1

Copy

Page 1 of 8

levins@medtechnica.co.il



Empower Support — Shula Levin, Medtechnica

a

Project Properties - "Defaul

Its*

General IEustom Fieldsl Accessl Integrityl Proceszing

Marne: |D efaults

Project Parent:

DOwner: |System

Syatern Suitahbility
GPC

M azs Spectrometry
CE/CIA

Dizzolution

Pattern katching
Chemical Stuchures

— D ata Files
Current Size of Raw D ata Files in Directony:

54.05 MB

dtabasze [ ablespace

Qunta; I?U _I; ME Free:| 5233 ME

General: Free tablespace must be at least 20% of the total quota

[ |

Cancel | Help

To see all projects datafiles size and tablespaces status: View-> Update statistics

15
File

hula/Power_user - Configuration M.
Edit | view Records Help

Toolhar
1|8t
é v View Filker Dialog Bar
] | v Status Bar

v JIT Dialog Bar

anager

=1a] x|

Updats |

lter By: |1t | Edit\iew

Comments

Edit Wiew

E & Em A
~B  System Policies. .,
-3 putodrchive Properties, .
2 SDMS Archive Properties, .,
B Cancel Pending SDIYS Gperations:
"€ Defaul Strings...
& Manage Raw Data Files...
2 Copy Preferences...
@ System Monitar, .
:g Custamize Time Zone List. .,

ack Integration for

Tablespacs Guota [Tablespace Fres |Fils Space Lised [Fils Spacs Free

Backup Options. ..
Datatiase Froperties ...,
Fre-3,00 Datahase Update ...

Updats Table

Refresh
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b. Custom Fields can be created or edited or copied
(see: http://www.forumsci.co.il/HPL C/custom_fields views.pdf)

Project Properties - "Defaults” ﬂ
General Custom Fields |.-’-‘n.c:c:ess| Integrit_l,.ll F'rocessingl
% Mame Twpe Field Type [¥Vidth [Precisio
1|Average Area_|Real (0.0) |Peak 12
Z|Corr_Perc_Are |Real (0.0)  |Peak 12
3 [Dilution Feal (0.0) [Sample i ]
4|End to Height |Real (0.0}  |Feak 12
515 N Feal (0.0) |Pealk 12
6|SampleMName |Text Sample 32-
7| SampleWeight |Real (0.0)  |Sample ™ ]
8 [Start_to_Height|Real (0.0) |Peak 12
A 2
Edit ... | Delete | Lock.f’UnI-:-ckl §avetoF‘roiect...|
ak | Cancel | Help |

C. Access settings according to company settings of 21CFRPart 11: Only those
who belong to the checked group can see the project.

Project Properties - '‘Defaults’ El

Generall Custom Figlds  Access | Integrit_l,ll F'ru:u:essingl

—Allowed Accezs—————————— Allow Accezs to Groups
" Dwner Orly .}'5-.|:|r|'|ir'|i:s:tratn:nr:i:
= Owner and Group | Guests
" Owner, Group and World | Medtechnica

Group User Type
ILlser's Dwn Type j

YWhorld Uzer Tepe
ILlser's Dwn Tupe j

k. I Cancel Help

c. Processing: select whether you can use "ApexTrack"
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2.

Empower Nodes (Computers), Server, LACE'sor client al in one list

% shula/Power_user - Configuration Manager

File Edt View Records Hslp

52 e e W - | 5 |Be| @2 | Finertos [Dotour <] Edtview
-]
Ed g\power Configuration = Emposwer Node Type | Cwner
Projects ET
BT o todes) e

Empovver Node Comments
Hone System

Gyeiene 2 |stuia_nb

Libraries

Empovver System
£ users

€% User Groups
£7 User Types
2 Plate Types
+%} System Audit Trail
Offline System Audit Trail

=10l x|

14| 4] v | ]|

Update | Max Rows |1000

Empower Node Name

For Help, press F1

Proel
3. Systems -> HPLC or GC or MS systems
Select the system, right click-> Properties

a. General:

Chromatographic System ‘demo_LC" Properkies

X
General | Configurationl Accessl

Empower Mode Mame:  Shula_nb

v Online

Systern Mame: IdBI‘ﬂD_LC

System Comment

Diemotztration only

o]

Cancel Help

b. Configuration

Chromatographic System 'demo_LC' Properties

x|
General  Configuration IAccessl

Dirag Components to/from the System Configuration list to alter its configuration.
MHote that you may open the other systems and move their components also.

Available Cormponents System Configuration
ﬁ demo L
{ell w2sans@7

=il W 2I9EE 2

QK I Cancel Help
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c. Access will determine if the user is able to work on the system: Set the permitted
user groups.

Chromatographic System ‘demo_LC* Properties

.l
L — .
Generall Configuration  Access | For client/server
only
¥ Share System with Other Metwork Users
—Allawed Access wrer:
£ Owener Only ISystem j
" wner and Group(s
pls] Allow Access o Group(z]:
£ Owner, Group and World —
[w]Adminiztrators
= JE 5 [Guests
azzword FProtect Access wMediechnica
k. I Cancel | Help
4. Libraries> PDA libraries (UV spectra)
5. Users
F-"shula,.-"Puwer_user - Configuration Manager ;lglﬂ
File Edit Wew Records Help
2|8 | g X| #|E|R[ Fierey [oer <] Ediview| Updme |Maxhows[1000 4] 4| B | B[]
- o
E--& mpnwer Configuration h Uszer Mame [Default User Type | User Status
2l Projects ED Scministrator Active
- =} Empower Nodes
g Systems 2
- Libraries 3 | System Administrator Active
o Jusers| 4 |TESTUSER | bcministrator | Active
€5 User Groups

-43% User Types

= @ Plate Types

= :g System Audit Trail

o5 Offline System Audit Trail

For Help, press F1

User
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To set the user's properties->right click-> properties. To create anew one: File->New
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Here the password and other parameters are set

User shula Properties |
Table Color Pref. | Plot Font Pref. | Plot Color Pref.
General | Uzer Types/Intertface | T able Font Pref.

zer Mame:  shula

Eull M aarme: IShuIamit Levin

Acocount Status: Iﬁ.c:tive j

— Pazzword

V¥ Password Fequired

Lurrent Pazziward I

Mew Paszword I

Confirmn Mew Pazswaord I

W illzer Must Change Passward at Mext Logir

0k, I Cancel | Apply | Help |

6. User groups-> Propertiesto add or remove users by checking them in. To create
anew one: File->New User Group
User Group Medtechnica Properties El

Group Properties | Admin Properties |

Group Marne: IMedtechnica

Group Adrin: I shula j

Ilzers in Group

wiGBa
[w]Spztem
[WwITESTUSER
[w]zhula

k. I Cancel Apply Help
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6. User Types-> Properties. Check the appropriate privileges.

Create custom users with your own privileges
User Type Administrator Properties {Reac x|

M anagement | Meth-:u:lsl Data .-'-‘-.u:quisitiu:unl

Privileges

[l drniriistratar m
[wtirchive and Remove Sample/Project Archives

[w]iew Syztem Audit Trailz

[wtrchive Spstem Audit Trails

[w]Clear/Restore Offine System Audit Trailz
[w]Clear/Restore Offine Projects/Sample Archives b
[w] R estore Autadrchived Projects

[w]Faszte Shallow Copies

[w]Lock Channels

[w]Unlock Channelz

[w]ilter Custom Fieldsz

[w]Create Cuztom Field

[w]D'elete Cuztom Field

[w]Lock Custom Field

[w]Unlock Custom Field

[w]tilter Diefault Strings j

Check 4l | Urhesk all | Firt |

[ I Cancel | Apply | Help |

System Audit Trail: Registered all configuration activities.

&, shula/Power_user - Configuration Manager ;IEIEI

File Edt Wiew Records Help

2|58 o] ¢ x| g{,||g|| Fiker By: [Detaut =] _EdtView | _ Updte | MasFows [1000 | 4 Llﬂ”

~m o
== Empower Configuration . Action Dretails ﬁl
Projects 1 |Modified System Empower Mode: Shula_nk System: demo_LC  Modified Systerm Comments: -= Demanstr
& Empower Nodes 2 |cCreated User Type shula
= Systems
[].3 Libraries 3 |Modified User Type Type: shula  Modified Run Empovwer 2QT: False -= True
- € Users 4 |niodified Lser Type Type: shula  Modified Create Projects at the Root: Falze -= True
g 3::: f;:'::s 5 |Modified User Type Type: shula  Modified Save M3 Calibration Methods: False -= Trus
@ Plate Types B |modified Lser Type Type: shula  Modified Delete MS Calibration Methods: False -= True
£ 7 |Madified User Type Type: shula  Madified Save Tune Methods: False = True
@ Dffline System Audit Trail 8 |modified User Type Type: shula  Modified Delete Tune Methods: Falze -= True
9 |miodified User Type Type: shula  Modified Alter Customized Time Zone List: Falze -= True
10 | Modified User Type Type: shula  Modified Allow Calibration & Quantitation in Revies: False -= Trug
1 | modified User Type Type: shula  Maodified View Quantitation Peak Fields in Review: False -= True
12 |Modified User Type Type: shula  Modifisd Allow Shallow Copies of FAT Projects: False -= Trug
13 | Modified User Type Type: shula  Modified Change Project Parent: False -= True
14 |Madified User Type Type: shula  Madified Access Real Time Review from Run Samples: False -= True
15 |Modified User Type Type: shula  Modified Unlock Custom Fielct False = True
16 |Modified User Type Type: shula  Modified Lock Custom Field: False -= True
AT |Modified User Type Type: shula  Modifisd Unlock Projects: False -= True
18 | Modified User Type Type: shula  Modified Lock Projects: Falze -= True
19 |Modified User Type Type: shula  Modifisd Modify Component ConstantsDefautt Amourts: False -= True
0| bdnctisian Lieay Tur, Torc shuls  bdecition Basu s ancl Colibestions in Ravicwe Eal Te had
4] | 0
For Help, press Fi ’W v
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The system audit trail can be archived. Right click->Archive. Binary format is just
for Empower, text is for outside reading.

I.'_-l shula/Power_user - Configuration Manager 10 x|
Fle Edit Yiew Records Help

Blsl8| o g x| 5[=[2]| Aebrfocon =] edtven | usdwe | Masoms [0 [4| 4| B[ M|
~m e

B2 Empower Configuration @ Action Details -
- Projects 1 |Modified System Empower Mode: Shula_nb  System: demo_LC  Modified System Comments: -= Demonstr
) Empower Nodes
Systems 2
Bl % Libraries 3 |mModitied User Type Binary n Empowver AQIT. Falze -= True
- @ Users 4 |Modified User Type Architve nd Remave... Text |eate Projects at the Root: False -= True
Q; User Groups 5 |mModified User Type Copy WModified Save MS Calibration Methods: False -» True
) % ll;'lsai::l";s)fs B |Modified User Type s Cein Modified Delete MS Calibration Methods: False -= True
= 7 |Modified User Type Shaw All Calumns Madified Save Tune Methods: False -= True
'g Offline System Audit Trail 8 |Madified User Type m hodifiedt Delete Tune Methads: False -= Trug
9 |Modified User Type _ b Modified Ater Customized Time Zone List: False -= True
10 | Modified User Type Table Properties.. Mosified Allow Calibration & Quartitation in Review: False -» Trug
11 |Modified User Type ol Fropzrtiss . Modified Yiew Guartitation Pesk Fields in Review: False -= True
12 |Modified User Type Type: shula  Modified Allow Shallow Copies of FAT Projects: False -= True
13 | Modified User Type Type: shula  Modified Change Project Parent: Falze -= True
14 |Modified User Type Type: shula  Modified Access Real Time Reviewy from Run Samples: False -= True
15 |Modified User Type Type: shula  Modified Unlock Custom Field: False -= True
16 | Modified User Type Type: shula  Modified Lock Custom Figld: False -= Trug
17 |Modified User Type Type: shula Modified Unlock Projects: False -= True
18 | Modified User Type Type: shula  Modified Lock Projects: Falze -= True
19 |Modified Uzser Type Type: shula  Modified Modify Component Constants/Default Amounts: False = True
o0 | btecifiact | e T T buda  hioclifiac Basubs and & alivatinns io Pavis: Cal ks i
0 o
Far Help, press F1 ’W v

The order of settings:

Create aUser-Type

Create a User, defining the User typein it

Create a Group in which you select the Users
Define the User Group/s in the Projects access tab
Define the User Group/s in the System access tab

agrwNPE
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